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AP - Accounts Payable 

Finding and Entering Suppliers 

Upon completion of this section, you will be able to:  

• Search for a supplier 

• Enter a supplier 

Searching for a Supplier 

Procedure 

 
In this simulation you will search for a supplier in the vendor file. 

 

 

Step Action 

1. The Search page provides multiple fields for you to enter data and search for a 

supplier.  

 

Note:  You can use the percent sign (%) as a wildcard to narrow your search.  

 

Hint:  To ensure a faster search, enter the first few characters of the Supplier 

Name and the Taxpayer ID number, which is a unique identifier.    
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Step Action 

2. Enter the Supplier Name (last name, first name) if entering an individual or the 

company name.   

 

In this simulation, search for Alex Hayes. Remember to search on the last name 

first. 

 

Enter "Hayes%". 

3. The Taxpayer ID is a unique identifier. Enter the Taxpayer ID, without hyphens.   

 

In this example, enter "852369741". 

4. The Show More Options link allows you to search by supplier type, etc. Typically 

you won't need to use this.  

5. Click the Go button. 

 

6. In this example, no results were found.   

7. In this example, searching by Supplier Name without the Taxpayer ID yielded 

results. View information for Hayes Group. 

 

Click the View button. 

 

8. Information on the Suppliers Quick Update, Company Profile, Organization, 

Address Book, Contact Directory, and Approval History  are available to view. 

9. Congratulations! You have completed the simulation on searching for a supplier in 

the vendor file. 

End of Procedure. 

Entering a Supplier into the Vendor File 

Search the system to verify the supplier is not in the vendor file prior to creating them.  
(See instructions in "Searching for a Supplier" topic). 

Procedure 

 
Note:  Remember that before you add a supplier you must first check to ensure that the supplier 

does not already exist in the vendor file (refer to topic Searching for a Supplier). 

 

In this simulation you will create a new supplier for inclusion in the vendor file. 
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Step Action 

1. Begin by clicking on the Create Supplier button. 

 

2. The Create Supplier page displays. Any information you entered for the search 

does not carry over so you will have to re-enter that information.  

 

Note: Vendors must be entered using upper case letters, so ensure the Caps Lock 

button is turned on! 

 

Enter "HAYES, AMY" in the Supplier Name field. 

3. Use the Special Status field only if you are paying one of the following special 

individuals or groups requiring an immediate payment: 

- Human subjects 

- Medical Center Employee 

- NRA UVA Fellows 

- Refunds 

- Research 

- UVA Fellows 

4. Enter the Taxpayer ID (without hyphens).   

 

Enter "852369741". 

5. Click the Apply button. 
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Step Action 

6. The Update [Supplier name] Organization page displays, with the supplier's name 

and number defaulted.   

 

Click the Organization link to access the Taxpayer ID information. 

 

7. The Taxpayer ID displays. 

 

Do not change any information on this page. 

8. Next, enter supplier address information. 

 

Click on the Address Book link. 

 

9. The Update [Supplier name]: Address Book page displays. 

 

Since you are creating a new supplier, click the Create button. 

 

10. The Create Address: Confirm Details page displays. You must complete the fields 

marked with an asterisk. 

 

Country is a required field. It defaults to the United States.  Use the list of values 

drop down menu if you need to select a different country, for example when adding 

a foreign supplier or individual.   

11. Enter the supplier's address, beginning with Address Line 1. 

 

For this example, enter "165 MADISON AVENUE" in the Address Line 1 field.  

12. Enter the City information. 

 

For this example, enter "NEW YORK" into the City field. 

13. Enter the State information.  

 

This is a free form field. 

 

Note:  Always enter the 2 character state code without spaces or punctuation, in all 

capital letters.   

 

Example:  NY (correct) 

                 N.Y. (incorrect) 

 

For this example, enter "NY" in the State field. 

14. Enter the Postal Code (zip code). 

 

For this example, enter "10016" in the Postal Code field.  
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Step Action 

15. The Address Name field is the geographic location of the supplier. This name will 

also become your Site name. 

 

Naming conventions: 

-  This field allows 15 characters. 

-  Always use the city name (NEW YORK, NEW YORK01, NEW YORK02). 

16. Enter the Address Name. 

 

For this example, enter "NEW YORK" in the Address Name field. 

17. The Communication Details box is checked by default.   

 

Do not uncheck it. 

18. Add a phone number. 

 

For this example, enter "212" in the Phone Area Code field. 

19. For this example, enter "875-2256" into the Phone Number field.  

20. The Address Purpose defaults to Payment.   

 

No action is required on your part.  Accounts Payable will select additional 

address purposes as needed when they enter the vendor's registration information 

into the system. 

 

Note:  If the supplier is needed immediately for an order in the Marketplace, contact 

Accounts Payable (924-4212) for their assistance.   

21. When you have completed entering address information, link the new address to a 

site. 

 

Click the Continue button. 

 

22. The Create Address: Site Creation page displays. Use this page to link the address 

to the site. 

 

Click the Select checkbox. 
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Step Action 

23. Click the Apply button. 

 

24. The Update [Supplier name]: Address Book page displays. You can edit the 

information using the Update icon. You can also use the Details Arrow link to 

access address details.   

25. Next, add supplier contact information.  

 

Click on the Contact Directory link. 

 

26. The Update [Supplier name]: Contact Directory page displays.   

 

Click the Create button. 

 

27. In this example, the contact information has been added for you. 

28. Click the Apply button. 
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Step Action 

29. A contact created confirmation message displays. 

 

You can change contact information by selecting the Update icon.   

 

If other supplier information needs to be changed, use the menu bar on the left side 

of the screen and select the page to be changed.   

 

Important Note:  When you exit the supplier pages, you will not be able to update 

the information via the system. Instead, you will complete the Vendor Sites 

Add/Update for Departments form located on the Procurement and Supplier 

Diversity Services website.   

30. Congratulations!  You have completed the simulation for entering a supplier into the 

Vendor File. 

End of Procedure. 

Payments 

Upon completion of this section, you will be able to: 

• Find a payment 

Finding Payments 

Procedure 

 
In this simulation, you will learn how to find a payment. 
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Step Action 

1. Click on UVA AP/PO Viewer to navigate to Payments. 

 

 

 

 
 

Step Action 

2. Click on Payments. 

 

3. The Find Payments page displays.   

 

Search for a payment by entering known data : 

Payment - check number 

Payee - Individual or Supplier receiving the payment 

Voucher Audit -  Payment Voucher number 

Status - Status, Dates, and Accounted 
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Step Action 

4. For this example, search by Payment Number (check number). 

 

Enter the desired information into the Payment: Numbers field. Enter "6024707". 

5. Press [Tab]. 
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Step Action 

6. Click the Find button. 

 

7. The Payments page displays. 

 

You can see the following information: 

Invoice number (205829) 

Date of the payment (28-OCT-2010) 

Amount ($13,134.28) 

GL Date (28-DEC-2010) 

Payment Amount ($13,134.28) 

8. You may also access the Payment Overview and Invoice Overview pages. 

9. Click the Payment Overview button. 

 

10. The Payment Overview page displays. 

 

Information pre-populates from the Payments page.   

 

Also provided is the Taxpayer ID and the Status of the payment.   

 

For this example, the Status of the Payment is Negotiable.   

11. The Invoices area list all invoices (by Invoice Number) paid with this payment.   

 

In this example, there is only one invoice. 

12. Click the Invoice Overview button. 

 

13. The Invoice Overview page displays. 

14. Click the Close button. 
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Step Action 

15. Click the Close button. 

 

16. Congratulations!  You have completed the simulation on how to find a payment. 

End of Procedure. 

Purchase Requisitions in the Integrated System 

Upon completion of this section, you will be able to: 

• Find a requisition 

• Print a requisition 

Finding a Requisition 

Procedure 

 
In this simulation you will locate a requisition. 
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Step Action 

1. To find a requisition, you must first go to the Requisition Summary.   

 

UVA PO Purchaser >> Purchasing >> Requisitions >> Requisition Summary. 

 

Click the Requisition Summary link. 

 

2. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. 

 

We recommend that you search either by Requisition Number or by Preparer 

name.  

3. You can also use the alternative region tabs to further restrict the search. 

4. If you don't know the requisition number or the preparer's name but you do know the 

purchase order number, choose the Related Documents tab and enter the number in 

the Purchase Order field. 

5. Choose which summary window to display by selecting from the Results group 

(Headers, Lines, Shipments, or Distributions).  

 

Depending on the search criteria you have specified, not all summary windows may 

be available. 

 

In this exercise use the default, Headers. 
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Step Action 

6. Click in the Requisition Number field. 

 

7. Enter the example requisition number. 

 

Enter the desired information into the Requisition Number field. Enter "1191381". 

8. Click the Find (B) button. 

 

9. The Requisition Headers Summary window displays. 

 

You cannot open the requisition. 
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Step Action 

10. Click the Lines button to view the requisition. 
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Step Action 

11. The Requisition Lines Summary page displays.  There are two lines.   

 

You can scroll across to view the requisition information. 

 

Click the Close button. 

 

 

 
 

Step Action 

12. Click the Close button. 

 

13. Congratulations, you have completed the simulation for finding a requisition. 

End of Procedure. 

Printing a Requisition 

Procedure 

 
In this simulation, you will see how to print a requisition. 
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Step Action 

1. To print a requisition, you must first run a report, and then use the print option. 

 

UVA PO Purchaser >> Purchasing >> Reports >> Run 

 

Click the Run link. 
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Step Action 

2. The Submit a New Request screen displays.  

 

Using the Single Request option (defaulted), click the OK button. 

 

3. To run this request, choose the name from the list of values. 

 

Click the Name... (ellipsis) button. 

 

4. Highlight the Printed Requisitions Report row. 

 

5. Click the OK button. 

 

6. Now enter values in the Requisition Numbers From and To fields. 

7. Enter the desired information into the Requisition Numbers From field. Enter 

"1191381". 

8. Press [Tab]. 

9. Enter the desired information into the Requisition Numbers To field. Enter 

"1191381". 
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Step Action 

10. Click the OK button. 

 

11. Click the Submit button. 

 

12. The request is in the Pending phase.   

Click the Refresh Data button. 

 

13. Phase changes to Completed when the report has run. 

 

Click the View Output button. 

 

14. This is an example of a requisition you could print (File>Print) for your records.   

15. Congratulations!  You have viewed the simulation on how to print a requisition. 

End of Procedure. 

Finding and Printing Purchase Orders in the Integrated System 

Upon completion of this section, you will be able to: 

• Find purchase orders 

• Print PDFs of purchase orders 

• View invoices 

Finding a Purchase Order 

Procedure 

 
In this simulation you will locate a purchase order. 
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Step Action 

1. From the UVA PO Purchaser menu on your Home page, navigate to the Find 

Purchase Order screen. 

 

Click the Purchasing link. 

 

2. Click the Purchase Orders link. 

 

3. Click the Purchase Order Summary link. 

 

4. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. 

 

We recommend that you search either by purchase order Number or by Buyer 

name.  

5. You can also use the alternative region tabs to further restrict the search. 

6. If you don't know the purchase order number or the buyer's name but you do know 

the requisition number, choose the Related Documents tab and enter the number in 

the Requisition field. 
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Step Action 

7. Choose which summary window to display by selecting from the Results group 

(Headers, Lines, Shipments, or Distributions).  

 

Depending on the search criteria you have specified, not all summary windows may 

be available. 

 

In this exercise use the default, Headers. 

 

 
 

Step Action 

8. Enter the purchase order number. 

 

Enter the desired information into the Number field. Enter "1699307". 

9. Click the Find (J) button. 
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Step Action 

10. The summary window displays the Headers page. 

 

Information that is found on the Purchase Order Headers page includes; a 

description of the purchase order, the approval status, name of the supplier, dollar 

amount, and the matched amount of the purchase order.  

 

Click the Open button. 

 

11. The purchase order displays. 

12. Congratulations!  You have completed the simulation for finding a purchase order. 

End of Procedure. 

Printing a Purchase Order in the Integrated System 

You may need to print a copy of the Purchase Order to deliver the purchase order to the 
Supplier/Vendor (by fax) or to keep a copy for your records/file. 
  

Also, if the purchase order is ever revised, you must print and deliver (fax, email, etc.) the 
revised purchase order to the Supplier/Vendor. 

Procedure 

 
In this simulation you will see how to print a purchase order.  
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Step Action 

1. From the UVA PO Purchaser menu on your home page, navigate to the Submit a 

New Request screen. 

 

Click the Reports link. 

 

2. Click the Run link. 
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Step Action 

3. The Submit a New Request screen displays.  

 

Using the Single Request option (defaulted), click the OK button. 

 

 

 
 



Training Guide 

 
Training Guide 

 

 Page 24 

Step Action 

4. To run this request, choose the name from the list of values. 

 

Click the Name... (ellipsis) button. 

 

5. Highlight the UVA Printed Purchase Order Report - PDF row. 

6. Click the OK button. 

 

7. Enter parameters for the following fields by choosing appropriate selections from 

the list of values. 

 

Click the Print Selection...(ellipsis) button. 

 

8. Use the default All. 

 

Click the OK button. 

 

9. Now enter values in the Purchase Order Numbers From and To fields. 

 

Press [Tab]. 

10. Enter the desired information into the Purchase Order Numbers From field.  

 

This is a REQUIRED field. 

 

Enter "1699307". 

11. Press [Tab]. 

12. The To field auto populates with the value in the From field. 

 

Click the OK button. 

 

13. Click the Submit button. 

 

 



 

Training Guide 
Training Guide 

 

 Page 25 

 
 

Step Action 

14. The request is in the Pending phase.  

  

Click the Refresh Data button. 

 

15. Phase changes to Completed when the report has run. 

   

Click the View Output button. 

 

 



Training Guide 

 
Training Guide 

 

 Page 26 

 
 

Step Action 

16. This is an example of a purchase order that you could print (File>Print) and fax to 

the supplier/vendor to place the order for goods and/or services or print the purchase 

order if it has been revised. 

 

Press [Enter]. 

17. Congratulations!  You have completed the simulation for prining a purchase order in 

the integraed system. 

End of Procedure. 

Viewing an Invoice 

Procedure 

 
In this simulation you want to view an invoice. 
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Step Action 

1. From your Home page, navigate to the Find Purchase Order screen. 

 

UVA PO Purchaser > Purchasing > Purchase Orders, click the Purchase Order 

Summary link. 
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Step Action 

2. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. We recommend that you search either by purchase order 

Number or by Buyer name. 

 

In this example, locate the PO using the PO number. 

 

Enter the desired information into the Number field. Enter "1087478". 

3. Click the Find (J) button. 

 

4. Instead of opening the PO, click the Inquire menu. 
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Step Action 

5. Click the View Invoices list item. 
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Step Action 

6. The invoice displays.  Here you can view the invoice date, supplier name, amount, 

payment status, po number, receipt, and attachments (if there are any). 

 

You can also view linked information. 

 

Click the Invoice link. 

 

7. Invoice information displayed includes general and payment details, an amount 

summary, and access to three tabs (Invoice Lines, Scheduled Payments, and Hold 

Reasons) for additional information. 

 

 
 

Step Action 

8. Click the Scheduled Payments tab. 
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Step Action 

9. Click the Hold Reasons tab. 

 

10. If the invoice is on hold, then the reason would be listed here. 

 

For this example, the invoice is not on hold.    

11. To exit the Invoice page, click the Return to Requisitions link. 

 

12. Congratulations!  You have completed the simulation for viewing an invoice. 

End of Procedure. 

Reviewing Receiving Transactions 

Reviewing a Receiving Transaction 

As needed, you can review your receiving transactions.  

Procedure 

 
In this simulation you want to review a recently received purchase order. 
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Step Action 

1. From your Home page, navigate to the Find Receiving Transactions screen. 

 

UVA PO Purchaser > Purchasing > Receiving, click the Receiving Transactions 

Summary link. 
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Step Action 

2. The Find Receiving Transactions screen displays. 

 

Choose the source type of Supplier. 

Click the Source Type list. 

 

3. Click the Supplier list item. 

 

4. To narrow your search, enter search criteria in other fields as desired, including 

Receipt number, Purchase Order number, Supplier name, and Receiving 

Location.  

 

You can use the ellipsis (...) in any field to select from the LOV. 

5. In this example, search by PO number. 

 

Press [Tab]. 

6. Enter the desired information into the Purchase Order field. Enter "1085154". 
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Step Action 

7. Click the Find button. 

 

8. The Receipt Headers Summary screen displays. If your search generated more 

than one transaction, place the current record indicator (blue box) next to the receipt 

you want to view. 
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Step Action 

9. Click the Transactions button. 

 

10. The Receipt Transaction Summary form displays. Scroll to view all information. 

 

Click the horizontal scrollbar. 

 

11. Click the horizontal scrollbar. 

 

12. Congratulations, you have completed the simulation for reviewing a receiving 

transaction. 

End of Procedure. 

Finding and Reviewing Payment Vouchers 

Finding and Reviewing a Payment Voucher 

You can find and review your payment vouchers using the Flashlight icon or by running a 
query on the voucher number. If you cannot recall the voucher number, you can query on 
the Trading Partner/Supplier name and the invoice number to find the payment voucher.  
  
Once the payment voucher has been approved, it is available for Accounts Payable 
(Procurement) to process the payment. If no changes are required, payment will be made.  

Procedure 
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This simulation shows two different methods of finding payment vouchers. 

 
 

Step Action 

1. Begin by navigating to the Payment Voucher form.   

 

Click on the Payment Voucher link to access the form. 

 

2. Method 1: Using the Flashlight icon. 

 

Click the Flashlight icon. 

 

3. The Find Invoices screen displays. 

 

You can search by Trading Partner/Supplier, Invoice Number or Voucher 

Number, or a combination of the three. 
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Step Action 

4. In this example, search for a payment voucher using the invoice number and 

voucher number. 

  

Click in the Invoice Number field. 

 

5. Enter the desired information into the Invoice: Number field. Enter "221". 

6. Click in the Voucher Audit Numbers: Start field. 

 

7. Enter the desired information into the Voucher Audit: Numbers: Start field. Enter 

"3311259". 

8. Press [Tab]. 

9. The voucher number automatically populates the Voucher Audit Numbers: 

End field. 

 

Click the Find button. 

 

10. The Payment Voucher displays. 

 

As needed, you can use the All Distributions button to review the distributions. 
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Step Action 

11. Method 2: Run a Query 

 

From the menu bar, select View>Query by Example>Enter.  

 

Click the Enter menu. 

 

12. Click in the Invoice Num field. 

 

13. Enter the desired information into the Invoice Num field. Enter "221". 

14. From the menu bar, select View>Query by Example>Run. 

 

 

Click the Run menu. 

 

15. The Payment Voucher displays. 

 

As needed, you can use the All Distributions button to review the distributions. 

16. Congratulations! You have completed the simulation for using two different 

methods to find payment vouchers. 

End of Procedure. 
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Viewing the Status of a Payment Voucher 

You may view the status of your payment voucher to determine whether it has been paid, 
the payment date, check number, etc.  
  
The Invoice Overview screen shows information about the payment voucher including:  

• status 

• current hold and reason, if any 

• scheduled due date 

  
Accessing Payment Overview  
  

If the payment voucher is paid, the check number, date, and amount paid is also shown on 
the Invoice Overview screen.  
  
You can click on the check number to activate the Payment Overview button.  
  
On the Payment Overview screen, you can see the address the check was sent to, the 

payee's name, and a list of invoices that were paid by the check. This information displays 
on the check stub that is received by the Trading Partner (Supplier).   
  
The status of the check, cashed or negotiable (not yet cashed) is also shown.  
  
  
  

  

Procedure 

 
In this simulation you will view a payment voucher to see information, including payment status 

and check number. 
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Step Action 

1. You will need to go to the Invoice Overview. 

 

UVA Purchaser >> Accounts Payable >> Invoices >> Inquiry >> Invoice Overview 

 

Click Invoice Overview 

 

 

 
 

Step Action 

2. The Find Invoices page displays. You can enter search criteria such as Trading 

Partner, Invoice Number, and/or Voucher number. 

 

For this example, search by the voucher number. 

 

Click in the Voucher Start Number field. 

 

3. Enter the desired information into the Voucher Start Number field. 

Enter "3205210". 

4. Press [Tab]. 
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Step Action 

5. The voucher number does not carry forward from the previous field.   

 

Enter the desired information into the Voucher End Number field. Enter 

"3205210". 

6. Click the Find button. 

 

7. The Invoice Overview page displays. 

 

Review the Invoice Status section. In this example, the payment status is Fully 

Paid.   

8. In this example the payment voucher is not on hold - the Active Hold and Reason 

sections are blank. It will be available for payment processing after Accounts 

Payable has reviewed it. 

 

If a hold is listed here, the payment cannot be made until Accounts Payable releases 

the hold. 

9. The Scheduled Payments and Actual Payments sections show payment details. 

 

Note the Paid By field. The check number and payment date is displayed here. 
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Step Action 

10. You can view more payment details. 

 

Click the Payment Overview button. 

 

11. The Payment Overview page displays. 

 

The payment in this example has a status of Negotiable. There is no date in the 

Cleared Date field, indicating that the payee has not yet cashed the check.  

12. The Invoices section populates with the invoice number and description entered on 

the payment voucher.    

13. From this page, you can return to the Invoice Overview page or access Payments. 

 

Bank and Supplier information is unavailable for review. 

 

 
 

Step Action 

14. Click the Close button. 

 

15. Congratulations! You have completed the simulation for viewing the status of a 

payment voucher. 

End of Procedure. 
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Running and Printing the Payment Voucher/Invoice Report 

Procedure 

 
You may need to print the payment vouchers you created. 

 

In this simulation, you will learn how to run and print the Payment Voucher/Invoice Report. 

 
 

Step Action 

1. Expand the Reports link to find the report. 

 

Click on the Run link. 
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Step Action 

2. The Submit a New Request page displays.  It automatically defaults to "Single 

Request". 

 

Click on the OK button. 
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Step Action 

3. Click on the drop down LOV for the Name field. 

 

 

 
 

Step Action 

4. Click the UVA Payment Voucher/Invoice Report. 
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Step Action 

5. Click the OK button. 

 

6. Enter parameters for your request.   

 

If you are printing a single payment voucher, enter the payment voucher number in 

the "Voucher Number From" and TAB.   

 

If you are running a report for multiple payment vouchers, enter a Voucher 

Preparer ID (user ID) AND a range of voucher numbers using the "Voucher 

Number From" and "Voucher Number To" fields. 

 

For this example, you will run a report for a single payment voucher. 

7. Click in the Voucher Preparer ID field. 

8. Enter your user ID into the Voucher Preparer ID field.  

 

Enter "JSJ6B". 

9. Click in the Voucher Number From field. 

 

10. Enter the payment voucher number you created into the Voucher Number 

From field.  

 

Enter "3311259". 
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Step Action 

11. Click on the OK button. 

 

12. Click on the Submit button. 

 

13. There are many phases when submitting a request ID to print. 

 

This request ID is in a "Pending" phase. 

 

As you continue to click on the Refresh Data button, it will move to "Running" 

and finally "Completed".  

 

 
 

Step Action 

14. Click on the Refresh Data button. 

 

15. Click on the Refresh Data button. 
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Step Action 

16. Notice the phase is now "Completed". 

 

Note: You must have Adobe Reader software that is compatible with your 

Windows version.  Contact your Local Support Partner (LSP) for assistance. 

 

Click on the View Output button. 

 

17. This is the output for payment voucher number 3311259. 

 

18. You may print the Payment Voucher/Invoice report by selecting File>Print. 

 

Another way to print the report would be to click on the printer icon on the browser 

toolbar.   

 

This report should be printed in landscape orientation. 

19. Congratulations!  You have completed the simulation on how to run and print the 

Payment Voucher/Invoice Report. 

End of Procedure. 

Working with Payment Vouchers 

Payment Voucher Overview   

  

Appropriate Uses of the Payment Voucher  

  

Check the Goods & Services Procurement Guide (http:www.procurement.virginia.edu/pageprocguidev2) on the 

Procurement website to see what commodities are allowed on a Payment Voucher as the policies can sometimes 

change.  

  

A Payment Voucher may be used for processing payments for the following items:  

• eVA-excluded items 

• Payments to individuals for research participation 

• Travel for official University travel, as documented on a travel workbook 

• Reimbursements to petty cash custodians, as documented on a petty cash workbook 

Some high-risk transactions automatically go on "HOLD" and require Procurement to release them.  

  

Paper Documentation Required 

 

There are two types of Payment Vouchers that require original paper documentation.  
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• Travel Reimbursement:  The original Travel Workbook and all supporting 
documentation must be submitted to Procurement. 

• Petty Cash Reimbursement:  The original Petty Cash reimbursement form and all 
supporting documentation must be submitted to Procurement.  The completed UVA 
Payment Voucher must be used as a cover sheet. 

The supporting documentation must be completed and approved prior to sending the paper documentation to 

Procurement.  The department originating the Payment Voucher will maintain the documentation for all other types of 

Payment Vouchers.  

  

  

Reimbursing Travel:  

The Payment Voucher form is used to reimburse costs incurred while on business travel.   

  

Before completing and submitting a payment voucher in the IS, employees must complete the Travel Workbook, which 

can be found on the Procurement and Supplier Diversity Services website.  

  

http://www.procurement.virginia.edu/pagetravelformlist  

  

Once the Travel Workbook has all the required signatures and supporting documentation (receipts), enter the payment 

voucher into the IS. The paper version of the Travel Workbook is sent to Procurement (Accounts Payable) for their 

review.   

  

You have the option to electronically attach the Travel Workbook to the payment voucher using the attachment 

(paperclip) icon. However, Accounts Payable will audit only the original paper documentation with receipts.  

  

Reimbursing Petty Cash:  

All petty cash custodians must be listed in the IS vendor file in order to receive payment. 
Custodians are added at the time the petty cash account is established. For example, they will 
be listed in the vendor file as "Custodian Webster, Donna".  

  

The Petty Cash custodian will prepare a Petty Cash Reimbursement form and submit it to the PO Purchaser 

for entering a payment voucher into the IS. 

  

Departments may have either cash or checking petty cash accounts. 

  

Not every department uses petty cash. The university is not opening any new accounts.   
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To start a simulation:  

  

1.  Double-click on the module.  

  

2.  Double-click on the section.  

  

3.  Click on the topic you wish to view.      

  

4.  Click "Try It" in the upper right-hand corner to interact with the simulation. Click "Print It" 

to print out a Job Aid.   

Entering Payment Voucher Information on the General Tab 
  

Procedure 

 
In this simulation you will begin by entering information on the General tab when creating a 

payment voucher. 
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Step Action 

1. Begin by navigating to the Payment Voucher form.   

 

Click on the Payment Voucher link to access the form. 

 

2. The Payment Voucher displays. 

 

You may use the predefined yellow folder (Payment Voucher R12) to rearrange 

the fields, but it is not required. 

 

The Type field defaults to Standard. Do NOT change it! 

3. The Trading Partner is the supplier/vendor, employee, or student you are paying.   

 

This is the name that will appear on the check. 

 

 
 

Step Action 

4. Click in the Trading Partner field.   

 

5. Click on the drop down list of values (LOV) to search for the Trading Partner. 

 

This list is the UVA Vendor file of those who can receive a payment.  
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Step Action 

6. Enter the Trading Partner name in the Find field.   

 

Note:  You can use the percentage (%) sign to narrow your search. 

 

For this example, you are searching for Journal of Bone & Joint Surgery. 

 

Enter the desired information into the Find field. Enter "journal of %". 

7. Click on the Find button. 

 

8. Choose from the resulting list. 

 

Click on Journal of Bone & Joint Surg. 

 

9. Click the OK button. 

 

10. The Supplier Number defaults when you select the Supplier/Trading Partner.   

 

It is the number generated by the system when the Supplier/Trading Partner is first 

entered into the system. 

11. The Supplier Site is the address information for the Supplier/Trading Partner. 

 

Click in the Supplier Site field. 

 

Note:  If there is only one site, it will default.  Otherwise, choose the site from the 

LOV. 

 

12. Click in the Invoice Date field. 

 

13. Click on the drop down LOV to access the calendar and select the date printed on 

the invoice. 
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Step Action 

14. In this example, the calendar displays for April. Select April 4th from the calendar. 

 

Click on 4. 

 

15. Click the OK button. 

 

16. The information entered in the Invoice Num and Description fields appears on the 

check stub or the Direct Deposit notification.   

 

This helps the payee identify the payment. 
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Step Action 

17. Click in the Invoice Num field. 
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Step Action 

18. The Invoice Num field is a free-form field.     

 

Enter the invoice number from the invoice. This number cannot be a duplicate.   

 

If this is a payment for an employee or a student and there is no invoice number, 

enter your email address prefix, followed by the current date (e.g., JSJ6B 7-APR-

2016). 

 

Note:  Always use upper case when entering verbiage. 

 

Enter "221" into the Invoice Num field. 

 

 
 

Step Action 

19. Enter the amount from the invoice into the Invoice Amount field.  

 

Enter "100.00" into the Invoice Amount field. 

20. Click in the Description field. 

 

21. The Description field appears on the check stub or the Direct Deposit notification to 

help the payee identify the payment. 

 

Enter "one year Dr McQ" into the Description field. 
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Step Action 

22. To access other fields on the form, click the horizontal scrollbar. 

 

 

23. Depending on the Trading Partner selected, the value in the Terms field defaults 

from the Vendor File.   

• Net 30 days defaults as the standard for most Trading Partners, suppliers, or 

vendors unless different terms have been negotiated with the Trading Partner. 

• Faculty, staff, and students terms default to Immediate.  

 

You are allowed to change the terms to Immediate when paying the following: 

- Human Subjects 

- Honoraria 

- Travel (non-employees) 

24. Click in the Date Invoice Received field. 

 

25. Click the drop down LOV to access the calendar. 
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Step Action 

26. The calendar displays with the current date selected.   

 

For this example, use the date shown as current (April 7). 

 

Click the OK button. 

 

 

 
 

Step Action 

27. Click in the Date Goods Received field. 

 

 

28. Click the drop down LOV to access the calendar. 
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Step Action 

29. For this example, the subscription begins on May 1. The calendar displays April and 

the first week of May.   

 

Click on 1 to select May 1, 2016. 

 

30. Click the OK button. 
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Step Action 

31. When you select a future date, the system generates a Caution note. 

 

Click the OK button to close the message. 
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Step Action 

32. Click the Save button. 

 

33. The system automatically generates a note that includes the payment voucher 

number.   

 

Important: Record the voucher number (In this example, 3311259) on the invoice.  

 

Click the OK button.   

 

34. Congratulations! You have successfully completed the simulation for entering 

information on the General tab when creating a payment voucher.  

 

The next topic shows you how to access the Lines tab and enter the PTAEO 

information. 

End of Procedure. 

Entering PTAEO Information on the Lines Tab 

Once the payment voucher General tab is completed and saved, and the system has 
generated a Payment Voucher Number, access the Lines tab to enter the PTAEO 
information for the payment voucher.   

 
  

Procedure 

 
In this simulation you will access the Lines tab and the Distributions page to enter the PTAEO 

information.   
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Step Action 

1. Click the 2 Lines tab.  
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Step Action 

2. Enter "100.00" into the Amount field.  

3. Enter the PTAEO information. 

 

Click the Distributions button. 

 

 

4. Note:  You may use the predefined yellow folder (Payment Voucher R12) to 

rearrange the fields for easier data entry. 

 

Do not enter information into the Account field! 

5. Notice there are many blank distribution lines available for you to use if you plan to 

split the payment voucher between several different PTAEOs.   

 

 
 

Step Action 

6. Enter "100.00" into the Amount field.  

7. Use your departmental PTAEO(s) when creating payment vouchers for your 

department. 

 

For this example, enter "101902" into the Project field.  

8. For this example, enter "101" into the Task field.  

9. Enter "sg00026" into the Award Number field.  
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Step Action 

10. Click on the Expenditure Type drop down LOV to see a list of expenditure types. 

 

11. You can use the Find field to search for an expenditure type. 

 

Click in the Find field. 

12. For this example, you are searching for Professional Licenses & Fees. 

 

Enter "profess%" into the Find field.  

13. Click the Find button.   

 

14. Notice that Professional Licenses & Fees defaulted because the LOV contained 

only one word beginning with "profess".   

15. Enter "20030" into the Expenditure Organization field.  

16. The Expenditure Item Date automatically defaults from the Invoice Date field. 

17. Save your work. 

 

Click the Save button. 

 

18. Close the window. 

 

Click the X button. 

 

19. Congratulations! You have successfully completed the simulation for accessing the 

Lines tab and the Distributions page to enter PTAEO information. 

 

In the next topic you will see how to use the Discard Line 1 button to create a 

reversal line if you entered an incorrect PTAEO.   

End of Procedure. 

Adding an Attachment to a Payment Voucher 

Procedure 

 
In this simulation you will add an attachment to a payment voucher. 
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Step Action 

1. Note:  Always add attachments on the General Tab so they are visible to others. 

 

Click the Attachments link. 
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Step Action 

2. Click in the Category field. 

 

3. Category must be Miscellaneous. You can use a shortcut for entering the value. 

 

Enter "m" into the Category field and [Tab] to the next field. 

4. You must enter text in either the Title and/or Description fields. 

 

Title is an optional free form field. It allows you to name the attachment.   

 

Enter "JB&JS Order Form" into the Title field and [Tab] to the next field.  

5. Description is a free form field used to explain what the payment is for. 

 

Enter a Description and [Tab] to the next field. 

 

Enter the desired information into the Description field. Enter "JB&JS Order 

Form". 

6. Click on the Data Type LOV. 

 

7. Choose from the list of options. File (Excel or Word document) is the default. Use 

this type in the example. 

 

Other Data Types are: 

- Long Text: A note up to 4,000 characters in length 

- Short Text: A note up to 2,000 characters in length 

- Web Page: Allows you to attach a web page 

 

Click the OK button. 
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Step Action 

8. Search for the file you wish to attach.  

  

Note: This opens in a separate screen and may open in the background. 

 

Click the Browse button. 
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Step Action 

9. Find the file you wish to attach. 

 

Double click on the file named "JB&JS.pdf". 
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Step Action 

10. Click the Submit button. 

 

 

 
 

Step Action 

11. Notice the Confirmation message with instructions. 

 

Click on the Close button. 
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Step Action 

12. A message asks if the file was uploaded successfully. 

 

Click the Yes button. 

 

13. Click the Open Document... button to verify the correct file is attached.  
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Step Action 

14. The attachment named "JB & JS Order Form displays. 

 

Click the Close button. 
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Step Action 

15. Save your work. 

 

Click the Save button. 

 

16. Click the Close button. 

 

17. Notice that the attachment link does not yet show a yellow paper under the 

paperclip, which indicates when an attachment is present.   

 

There are several ways to refresh the screen to see the attachment.  

18. One way to refresh the attachment link is to click first on the Lines tab, then click 

back on the General tab.  

19. Notice the yellow paper is now visible under the paper clip. 

20. Congratulations!  You have successfully completed the simulation for adding an 

attachment to a payment voucher. 

End of Procedure. 

Approving Payment Vouchers 

Procedure 

 
In this simulation you will approve and submit a payment voucher. 
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Step Action 

1. Click the Actions... 1 button. 

 

2. The Payment Voucher Actions page displays. 

 

There are many actions to choose from.    

 

Next you will see a description for each of them. 

 

 
 

Step Action 

3. This page describes each payment voucher action.   

 

Note: The most important action button is All Approvals Have Been 

Obtained. You must select it each time you request a payment! 

 

You may select multiple buttons at once. 
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Step Action 

4. In this example, click on the All Approvals Have Been Obtained checkbox. 

 

5. Click the OK button. 

 

6. The Status of the payment voucher will be one of the following: 

  

- Never Validated: The All Approvals Have Been Obtained button has not been 

selected. The payment voucher will not be reviewed or approved by Procurement.  

     

- Needs Revalidation: The Payment Voucher requires final approval by Accounts 

Payable (all Travel & Petty Cash).  

 

- Validated: The payment will be scheduled after AP reviews the voucher.  

 

- Cancelled: The payment voucher has been cancelled. Look for additional 

information via the attachment (paper clip) icon. 

7. Congratulations!  You have successfully completed the simulation for approving and 

submitting a payment voucher. 

End of Procedure. 

Deleting a Payment Voucher 

You can delete a payment voucher if you have entered and saved it (including 
distributions) but have not validated (approved) it - the status of the payment voucher is 
Never Validated.  
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Once you validate a payment voucher, you cannot delete it.   
  
Deleting a payment voucher permanently removes it from the system.   

Procedure 

 
In this simulation you will delete a payment voucher that has been entered and saved but not 

validated (approved). 

 
 

Step Action 

1. First, search for the payment voucher to be deleted by clicking the Flashlight icon. 

 

Another method is to select View>Find from the menu bar. 
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Step Action 

2. The Find Invoices screen displays. 

 

To search by voucher number, click in the Voucher Audit: Numbers: Start field. 

 

3. Enter the desired information into the Voucher Audit: Numbers: Start field. 

Enter "2367356". 

4. Press [Tab]. 

5. The voucher number automatically populates the Voucher Audit: Numbers: 

End field. 

 

Click the Find button. 

 

6. Verify the payment voucher displayed is the one to be deleted and that the status is 

Never Validated. 
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Step Action 

7. To delete the payment voucher, click the red X icon. 

Click the Delete button. 

 

8. A caution message displays. This action cannot be undone. 

 

Click the OK button. 

 

9. To finalize deletion of the payment voucher, click the Save button. 

 

10. Congratulations! You have completed the simulation for deleting a payment 

voucher.   

End of Procedure. 

Changing and Resubmitting a Payment Voucher 

There may be situations where you need to change a validated payment voucher. You must 
make these changes shortly after submission:  
  

• Faculty, Staff and Students payment terms are set for "Immediate". Therefore, any 
changes to payments reimbursing these groups must be done the same day the 
payment voucher is submitted into the system.    

• Trading Partner/Suppliers Terms are set most often to "Net 30 days". Therefore, any 
changes to payments for these groups have a window of approximately 10 working 
days before the payment is processed by Accounts Payable.  
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No changes are allowed if the payment voucher has been paid.   
  
Check the status of the payment voucher to determine if it has been paid BEFORE you 
attempt to change it:  

• To verify that the invoice has not been paid, use Invoice Overview. Navigate to 
Accounts Payable: Invoices: Inquiry>Invoice Overview to determine the status of 
the payment voucher.   

  
If the payment voucher has been paid and the PTAEO information is incorrect, someone 
must process a GA Transaction (Cost Transfer) to make the correction. 
  
The following fields may be changed on a validated (approved) but not yet paid payment 
voucher:  

• Distributions (PTAEO) 

• Dollar Amount 

  
Rejection of Payment Vouchers 
If Procurement rejects your payment voucher, you will receive an email notification with 
the invoice number and vendor name of the rejected payment voucher. Procurement will 

document the reason(s) for rejecting the payment voucher by using the attachment 
(paperclip) functionality in the IS system.  
  
If you want to correct the problem with the payment voucher, you may do so and resubmit 
it to Procurement (Accounts Payable).  
  

Correcting Payment Voucher Holds  

The following are holds that require user correction:  
  
Voucher Returned to Dept: This hold indicates Procurement Services requires additional 
information before the transaction can be processed. You can use the paperclip to see what 
information is required. This alerts Procurement Services that the department has supplied 
the required information.  

  
Petty Cash Hold: This hold indicates the original documentation has not been received or 
reviewed by Procurement. Please ensure this paperwork is complete and forwarded to 
Procurement.  
  
Requires an Attachment: This hold indicates you requested original documentation to be 
mailed with the check, however the paperwork has not been received by Procurement. 

Payment cannot be processed until this paperwork is received.  
  
Restricted Item: This system hold is caused when a user selects a high-risk expenditure 

type. It requires Procurement to release this hold after review. It often indicates the 
original travel workbook has not been received or reviewed by Procurement. You must 
submit any required paperwork to Procurement as soon as possible.  

  
Dept. Hold: This hold is put on the transaction per the department’s request. Please 
resolve this issue and alert Procurement to remove the hold by using the 
Invoice/Correction Action form on Procurement’s website. Examples of resolution would be 
to contact the vendor and request the vendor to resend the bill after the issue is resolved. 
You can also partially pay an invoice but be sure the vendor is aware they need to send an 
invoice for the additional amount at a later time.  
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Awaiting Credit Memo: Contact the vendor and ask them to send a credit memo so this 
hold can be released. You do have the option to partially pay an invoice but be sure to alert 
the vendor so they can correct their records.  

  
Distribution Variance: This is a system hold. It indicates that the invoice header amount 
and the invoice distribution amounts do not agree. Query the payment voucher in IS and 
make changes to either the header or distribution form, then approve the transaction.  
  
Resubmit PV: This hold indicates Procurement originally returned the payment voucher to 
the department. After supplying requested information, the user checked “Resubmit PV” on 

the approval screen in the Integrated System. If you feel you have supplied all required 
information and this hold does not seem to be released, please contact Procurement 
Services immediately.  
  

  
Procurement Services will handle all other holds.  No user action is required 

unless requested. 

Procedure 

 
Begin by locating the payment voucher that requires changing. (Refer to the Finding and 

Reviewing a Payment Voucher topic.) 

 

Note: If you are changing the dollar amount of the payment voucher, then first work with the 

Discard Lines button and Distributions.  

 

In this simulation, Accounts Payable has rejected your payment voucher because of an incorrect 

expenditure type. Change and resubmit the payment voucher to Accounts Payable. 

 
 



 

Training Guide 
Training Guide 

 

 Page 79 

Step Action 

1. Step 1: View the Reason for Rejection 

 

Within the Payment Voucher, view the reason(s) Accounts Payable rejected it. 

 

Click the attachment (paperclip) icon. 

 

 

 
 

Step Action 

2. The Attachments screen displays. When you click in the Category field, the notes 

display.  

 

In this example, the first entry (Main Seq 10) contains the note you wrote when 

completing the payment voucher. 

 

The second entry (Main Seq 20) indicates a wrong expenditure type was used. 

 

Click in the Category field.  

 

3. The attached note displays. 
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Step Action 

4. Now you can correct the payment voucher. 

 

Click the Close button. 

 

 

 
 

Step Action 

5. Step 2: Correct the Payment Voucher 

 

Since in this example the expenditure type needs to be changed, first review the 

original PTAEO information. 

 

Click the All Distributions button. 

 

 



 

Training Guide 
Training Guide 

 

 Page 81 

 
 

Step Action 

6. To view the fields on the right, click the horizontal scrollbar. 

7. The PTAEO information displays. 

 

Click the Close button. 
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Step Action 

8. Next, reverse the original PTAEO information. 

 

Click the 2 Lines tab. 

 

9. Click the Discard Line 1 button. 

 

10. Notice that the amount for line 1 is now a zero dollar amount. 

 

You will re-enter the dollar amount (on the next available line). 

11. Click in the Amount field.   

 

12. Enter the desired information into the Amount field. Enter "500.00". 

13. Enter the correct PTAEO information, including the new expenditure type.  

 

Click the Distributions button. 
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Step Action 

14. Click in the Amount field. 

 

15. Enter the desired information into the Amount field. Enter "500.00". 

16. Click in the Project field. 

 

17. Enter the desired information into the Project field. Enter "101902". 

18. Press [Tab]. 

19. Enter the desired information into the Task field. Enter "101". 

20. Press [Tab]. 

21. Enter the desired information into the Award Number field. Enter "LG00005". 

22. Press [Tab]. 

23. You can search for an expenditure type. 

 

Click on the Expenditure Type... button. 

 

24. The LOV displays.  

 

Click in the Find field. 

25. Enter the desired information into the Find field. Enter "Honoraria%". 

26. Click the Find button. 

 

27. The expenditure type populates the field. 

 

Press [Tab]. 

28. Enter "20030" into the Expenditure Organization field. 

29. Press [Tab]. 

30. Save your changes. 

 

Click the Save button. 

 

31. Click the Close button. 
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Step Action 

32. Write a note to Accounts Payable by clicking the attachment (paperclip) icon. 

 

 

 
 



 

Training Guide 
Training Guide 

 

 Page 85 

Step Action 

33. Click in the next available Category field. 

 

34. You can use shortcuts to enter the category. 

 

Enter "m" into the Category field. 

35. Press [Tab]. 

36. Enter text in either the Title and/or Description fields. 

 

For this example, enter "Corrected exp type" into the Title field. 

37. Press [Tab]. 

38. From the Source tab, enter the Data Type. 

 

Click the Data Type... button. 

 

39. Choose from the LOV. For this exercise, choose Short Text. 

 

Click the Short Text list item. 

 

40. Click the OK button. 

 

41. Write a short text note.   

 

In this example, a note has been entered for you. 

42. Save your entry. 

 

Click the Save button. 

 

43. Click the Close button. 
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Step Action 

44. Step 3: Resubmit the Payment Voucher 

 

Click the Actions... 1 button. 

 

45. If needed, you may select multiple Payment Voucher Actions checkboxes. 

 

However, if both the All Approvals Have Been Approved and the Resubmit to 

Accounts Payable buttons are selected, then the system generates the following 

note."The Fiscal Classification Code is not associated with any Item Category 

Code". Click OK and the note will go away. 

 

Important: When resubmitting a payment voucher to Accounts Payable, do not 

select the All Approvals Have Been Obtained button. 
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Step Action 

46. Click the Resubmit to Accounts Payable checkbox only.  

 

47. Click the OK button. 
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Step Action 

48. A note displays.  

 

Click the OK button. 

 

49. The next note informs you that the payment voucher is awaiting Accounts Payable's 

review.   

 

Click the OK button. 

 

50. To view the status of the payment voucher, click the 1 General tab. 

 

51. The Status section displays the information that the status of the payment voucher is 

Needs Revalidation, and that there is one Hold placed on it.    

 

If the requested changes have been completed and they do not require additional 

information or further changes, Accounts Payable will review the payment voucher, 

release the hold, and process the payment. 

52. Congratulations! You have completed the simulation for changing and resubmitting 

a payment voucher. 

End of Procedure. 

Using the Discard Line1 Button 

The Discard Line1 button creates a reversal line for each previously entered PTAEO.   
  
You will use the Discard Line 1 button to correct the PTAEO information which you had 
previously entered and saved, but later determined was incorrect.   

  
Note:  The system will not let you change PTAEO information once it has been saved!  

Procedure 

 
In this simulation you will use the Discard Line1 button to reverse incorrect PTAEO information 

entered on a payment voucher.   
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Step Action 

1. Begin by clicking on the 2 Lines tab. 

 

2. Important Note: When you select this button, the system creates a reversal for 

EVERY distribution line entered.   

 

Click on the Discard Line 1 button.   

 

 

3. The line amount is now zero (0.00).   

4. View the new distribution lines. 

 

Click the Distributions button.  

 

5. The Line Total and Distribution Total fields show zero. 

 

A new line was automatically created to offset each line previously entered. 
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Step Action 

6. Click the Close button. 

 

7. The Discard Line1 and Distributions buttons are inactive (grayed out) for the Num 

1 line. 

 

Next, you will see how to enter a new line and distribution for the Payment 

Voucher. 
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Step Action 

8. You will re-enter the dollar amount and the new distribution (PTAEO) line(s) on the 

next available line.   

 

Notice both the Discard Line 2 and Distributions buttons are now active. 

 

Click in the Amount field for line 2. 

 

 

 

9. Notice the Discard button is now named Discard Line 2. 

 

Enter "100.00" into the Amount field.  

10. Click the Distributions button. 

 

11. Notice the Line and Distribution Totals do not agree. 
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Step Action 

12. Click in the Amount field. 

 

13. Notice the Line Number is 2. 

 

Enter "100.00" into the Amount field.  

14. Click in the Project field. 

 

15. Notice the Line and Distribution Totals agree and are no longer red. 

 

Enter the PTAEO. 

 

Enter "129924" into the Project field.  

16. Scroll to access other fields. 

 

Click the horizontal scrollbar. 

17. Enter "101" into the Task field.  

18. Enter "LS00347" into the Award Number field.  

19. Click in the Expenditure Type field. 

 

20. You can use the Find feature to locate an expenditure type. 

 

Click in the Find field. 
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Step Action 

21. Enter "Profess%" into the Find field.  

22. Click the Find button. 

 

23. The Expenditure Type field populated with one choice based on your search in the 

LOV. 

24. Enter "20030" into the Expenditure Organization field. 

25. Save your work. 

 

Click the Save button. 

 

26. Click the Close button. 

 

 

 
 

Step Action 

27. Click on the 1 General tab to view all distributions. 

 

28. Click the All Distributions button to view the newly added distribution line. 
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Step Action 

29. The Distributions page displays. 

 

 
 

Step Action 

30. Note:  Whenever you change a payment voucher, remember to approve and submit 

it to Accounts Payable. Refer to the Approving Payment Vouchers topic for more 

information. 

 

Click the Close button. 

 

31. Congratulations! You have successfully completed the simulation for using the 

Discard Line1 button to reverse incorrect PTAEO information entered on a 

payment voucher.   

End of Procedure. 

Canceling a Payment Voucher 

After creating a payment voucher you may find that you need to cancel it.   
  
You can cancel a payment voucher if the payment voucher status is Validated and it has 
not been paid.  
  
Check the status of the payment voucher to determine if it has been paid BEFORE you 
attempt to cancel it.  
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• To verify that the payment voucher (invoice) has not been paid, use Invoice 

Overview. Navigate to Accounts Payable: Invoices: Inquiry>Invoice Overview to 
determine the status of the payment voucher.   

  

Procedure 

 
In this simulation you will cancel a payment voucher. 

 
 

Step Action 

1. First, search for the payment voucher to be canceled by clicking the Flashlight icon. 

 

Another method is to select View>Find from the menu bar. 
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Step Action 

2. Click in the Voucher Audit: Numbers: Start field. 

 

3. Enter the desired information into the Voucher Audit: Numbers: Start field. Enter 

"2367369". 

4. Press [Tab]. 

5. The voucher number automatically populates the Voucher Audit: Numbers: 

End field. 

 

Click the Find button. 
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Step Action 

6. The Payment Voucher displays. 

 

Reverse the original information. 

 

Click the 2 Lines tab. 
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Step Action 

7. Click the Discard Line 1 button. 

 

8. Click the 1 General tab. 

 

9. Review the new distribution lines. 

 

Click the All Distributions button. 

 

10. The Distribution Total is now zero (0). 

 

Next you will change the Invoice Total to equal the Distribution Total (zero). 
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Step Action 

11. Click the Close button. 

 

 

 
 



Training Guide 

 
Training Guide 

 

 Page 100 

Step Action 

12. Refresh the page by re-querying the payment voucher.   

 

Click the Flashlight icon. 

 

 

 
 

Step Action 

13. Re-enter the Voucher Audit: Start and End Numbers. 

 

In this example, the numbers have been entered for you. 

 

Click on the Find button. 
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Step Action 

14. The Payment Voucher form displays. Next, change the invoice amount to zero. 

 

Click in the Invoice Amount field. 

 

 

15. Enter the desired information into the Invoice Amount field. 

 

Enter "0".  

 

16. Save your changes. 

 

Click the Save button. 

 

17. Write a note to Accounts Payable concerning your actions. 

 

Click the Attachments (paperclip) icon. 

 

(If this action results in a Java Security Warning dialog box, click Yes.)   

 

18. Enter the category and a title and/or description. 

 

In this example, the fields have been completed for you. 
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Step Action 

19. Choose a data type and enter information, then save your work. 

 

In this example, a short text message has been entered for you. 

 

 
 

Step Action 

20. Click the Close button. 
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Step Action 

21. Finally, resubmit the voucher. 

 

Click the Actions... 1 button. 
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Step Action 

22. Check the Resubmit to Accounts Payable box. 

 

23. Click the OK button. 

 

24. The payment voucher displays a zero (0) invoice amount and a zero (0) distribution 

amount. 

 

Important Note: Complete and submit an Invoice Correction form (Procurement 

and Supplier Diversity Services website) to inform Accounts Payable of the 

cancellation. 

25. Congratulations! You have completed the simulation for canceling a payment 

voucher. 

End of Procedure. 

Working with Fellows Stipends 

The UVa Fellow or NRA (Nonresident Alien) UVa Fellow is an individual who is not a UVa 
employee or a UVa student.   

  

The Fellow receives financial assistance to pursue study or training for which there is no 
obligation to perform services.   

  

They are sometimes referred to as PostDoc Fellows.  

  

Note: If you are processing a stipend payment for a student, such as a Graduate Fellow PhD 
candidate or a Graduate Fellow MBA candidate, then use the Student Aid Funding Module 

(SAFM) in the Student Information Systems (SIS). Otherwise, use this responsibility.  

  

Upon completion of this section, you will be able to:  

• Search for and enter fellows into the Vendor File 

• Create Distribution Sets 

• Create and approve Recurring Invoices 

• Run and print the Payment Voucher/Invoice Report 

Searching for Fellows in the Vendor File 

Procedure 

 
In this simulation you will search in the UVA Vendor File for individuals you need to pay that are 

considered a UVA Fellow or NRA UVA Fellow. 
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Step Action 

1. To search for fellows in the vendor file, you first go to Supplier Entry. 

 

UVA AP Fellows Stipend Processor >> Supplier Entry. 

 

Click on Supplier Entry. 

 

2. The Search page provides multiple fields for you to enter data and search for a 

supplier/Fellow.  

 

Note:  You can use the percent sign (%) as a wildcard to narrow your search.  

 

Hint:  To ensure a faster search, enter the first few characters of the Supplier 

Name and the Taxpayer ID number, which is a unique identifier.    

3. Enter your search parameters. 

 

The recommended parameters are the Supplier Name (last name, first name) if 

entering an individual, and the Taxpayer ID (SSN).  

 

In this simulation, search for Alex Hayes.  

 

Enter "Hayes%". 

4. The Taxpayer ID is a unique identifier. Enter the Taxpayer ID, without hyphens.   

 

In this example, enter "852963741". 
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Step Action 

5. Click the Go button. 

 

6. The search returned the following results.  

 

If no results were shown, you would need to create the supplier before you can 

create recurring invoices to pay them. This will be shown in the next topic, 

"Entering Fellows into the Vendor File". 

7. Congratulations! You have completed the simulation on searching for a 

supplier/Fellow in the vendor file. 

End of Procedure. 

Entering Fellows into the Vendor File 

After searching and finding that the UVA Fellow or NRA UVA Fellow is not in the UVA Vendor 
File, you will create the supplier (fellow) and add them to the vendor file.  
  
Note: If the supplier (fellow) already exists in the Vendor File with a type other than UVA 
Fellow or NRA UVA Fellow, then the department needs to complete a Vendor Registration 
for Vendors/Individuals 
(https://www.procurement.virginia.edu/pagevendorregistrationform) form located on the 
Procurement and Supplier Diversity Services web site (see Forms). 

Procedure 

 
Note:  Remember that before you add a supplier/fellow, you must first check to ensure that they 

do not already exist in the vendor file (refer to topic Searching for Fellows in the Vendor File). 

 

In this simulation you will create a new supplier (fellow) for inclusion in the vendor file. 

https://www.procurement.virginia.edu/pagevendorregistrationform


 

Training Guide 
Training Guide 

 

 Page 107 

 
 

Step Action 

1. Begin by clicking on the Create Supplier button. 

 

2. The Create Supplier page displays.  

 

Note: Vendors (Fellows) must be entered using upper case letters, so ensure the 

Caps Lock button is turned on! 

 

Enter "SPEAKER, STEVE" in the Supplier Name field. 

3. Enter information into the Special Status field to designate that this vendor is either 

a UVA Fellow or a NRA UVA Fellow. 

 

For this example, UVA Fellow has been entered for you. 

4. Enter the Taxpayer ID (without hyphens).   

 

Enter "456123789". 

5. Click the Apply button. 

 

6. The Update [Supplier name] page displays, with the supplier's name and number 

defaulted.   

 

Click the Organization link to access the Taxpayer ID information. 
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Step Action 

7. The Taxpayer ID displays. 

 

Do not change any information on this page. 

8. Next, enter supplier address information. 

 

Click on the Address Book link. 

 

9. The Update [Supplier name]: Address Book page displays. 

 

Since you are creating a new supplier, click the Create button. 

 

10. The Create Address: Confirm Details page displays. You must complete the fields 

marked with an asterisk. 

 

Country is a required field. It defaults to the United States.  Use the list of values 

drop down menu if you need 

 to select a different country, for example when adding a foreign supplier or 

individual.   

11. Enter the supplier's address, beginning with Address Line 1. 

 

For this example, enter "123 MAIN STREET" in the Address Line 1 field.  

12. Enter the City information. 

 

For this example, enter "ANYTOWN" into the City field. 

13. Enter the State information.  

 

This is a free form field. 

 

Note:  Always enter the 2 character state code without spaces or punctuation, in all 

capital letters.   

 

Example:  VA (correct) 

                 V A. (incorrect) 

 

For this example, enter "VA" in the State field. 

14. Enter the Postal Code (zip code). 

 

For this example, enter "12345" in the Postal Code field.  
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Step Action 

15. The Address Name field is the geographic location of the supplier. This name will 

also become your Site name. 

 

Naming conventions: 

-  This field allows 15 characters. 

-  Always use the city name (ANYTOWN, ANYTOWN01, ANYTOWN02). 

16. Enter the Address Name. 

 

For this example, enter "ANYTOWN" in the Address Name field. 

17. The Communication Details box is checked by default.   

 

Do not uncheck it. 

18. Add a phone number. 

 

For this example, enter "434" in the Phone Area Code field. 

19. For this example, enter "999-1212" into the Phone Number field.  

20. The Address Purpose defaults to Payment.   

 

No action is required on your part.  Accounts Payable will select additional 

address purposes as needed when they enter the vendor's registration information 

into the system.   

21. When you have completed entering address information, link the new address to a 

site. 

 

Click the Continue button. 

 

22. The Create Address: Site Creation page displays. Use this page to link the address 

to the site. 

 

Click the Select checkbox. 
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Step Action 

23. Click the Apply button. 

 

24. The Update [Supplier name]: Address Book page displays. You can edit the 

information using the Update icon. You can also use the Show arrow link to access 

address details.   

25. Next, add supplier contact information.  

 

Click on the Contact Directory link. 

 

26. The Update [Supplier name]: Contact Directory page displays.   

 

Click the Create button. 

 

27. In this example, the contact information has been added for you. 

28. Click the Apply button. 
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Step Action 

29. A contact created confirmation message displays. 

 

You can change contact information by selecting the Update icon.   

 

If other supplier information needs to be changed, use the menu bar on the left side 

of the screen and select the page to be changed.   

 

Important Note:  When you exit the supplier pages, you will not be able to update 

the information via the system. Instead, you will complete the Vendor Sites 

Add/Update for Departments form located on the Procurement and Supplier 

Diversity Services website.   

30. Congratulations!  You have completed the simulation for entering a supplier into the 

Vendor File. 

End of Procedure. 

Creating Distribution Sets for Recurring Invoices 

The Distribution Set is where you record the PTAEO(s) that will be charged for the 
recurring invoices you create.   
 
It becomes the distribution line(s) for the invoice(s).  
 
A distribution set can be used for any recurring invoices and can include multiple PTAEO's 
which can be split on a percentage basis. 

Procedure 

 
In this simulation you will learn how to create a distribution set for a recurring invoice(s). 
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Step Action 

1. Navigate to the Distribution Sets page from the UVA AP Fellows Stipend 

Processor responsibility. 

 

Click on the UVA AP Fellows Stipend Processor folder. 

 

 

 
 

Step Action 

2. Click on the Distribution Sets link. 
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Step Action 

3. Click in the Name field to enter a unique name for the distribution set. 

 

The distribution set name must be specific as it will identify the source of funds and 

your department. 

 

Note: When searching for your distribution set name, you will see ALL distribution 

sets for the entire university. 

 

4. Enter the distribution set Name. 

  

For this example, enter "NIH Chemistry 2011 Fellowship". 

5. The description field provides more detailed information. 

 

Click in the Description field. 

6. Enter a Description.  

 

For this example, enter "Chemistry NIH Greenhouse fellowship for 2011". 

7. Click in the Num field.  The number 1 defaults. 

 

Note: You may use the TAB key to move to the next field. 
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Step Action 

8. The percentage (%) field represents the percent of the total payment that will be 

charged to the PTAEO. 

 

Note:  Use 100% if there is only one PTAEO.  If more than one PTAEO will fund 

the recurring invoice(s), use the appropriate % for each PTAEO.  The percentages 

must total to 100%. 

 

Enter the Distribution Percentage. 

 

For this example, enter "100". 

9. Click in the Project Related box to record the PTAEO information.   

 

10. Enter the Project number.   

 

For this example, enter "105300". 

11. Click in the Task field. 

 

12. Enter the Task number.  

 

For this example, enter "101". 

13. Enter the Award Number.  

 

For this example, enter "DR01246". 

14. Click in the Expenditure: Type field. 

 

15. Click on the Expenditure: Type list of values button. 

 

16. Click in the Find field. 

 

17. Enter the desired information into the Find field.  

 

Enter "Fell%". 

18. Click on the Find button. 

 

19. Click on and select "Fell, Stipends, Non-Student". 

 

Note: This will always be the appropriate expenditure type. 
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Step Action 

20. Click on the OK button. 

 

21. Enter the Expenditure: Organization number. 

 

For this example, enter "31695" and TAB.  

22. Click on the OK button. 

 

23. Click on the Save button. 

 

24. Notice the corresponding General Ledger account string is created. 

25. Click on the Project Information button to view the PTAEO. 

 

26. The distribution set can be changed at this time if needed.   

 

If no changes are required, click on the OK button. 

 

27. Click on the (X) Close button. 

 

28. Congratulations!  You have successfully completed the simulation on how to create 

a distribution set.  

End of Procedure. 

Creating Recurring Invoices 

The Recurring Invoices functionality allows you to create multiple invoices to the same 
payee by completing a recurring invoice template.   
 
Invoices are for current and future periods of time.  When the invoices are created, they 
are validated for transaction controls and the PTA used is not closed for the periods used. 
  
Note:  Prior to creating the recurring invoice template, two things should have been 

completed.  

 
-  The payee must be in the vendor file with the vendor type of UVA Fellow or NRA UVA 
Fellow. 
 
-  The Distribution Set must be created.  
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Note: UHR must review all recurring invoices for NRA (Non-Resident Aliens) individuals 
prior to payment. Allow approximately 2 business days after submission of the vendor add 
form before creating and approving the recurring invoices to pay NRA individuals.  

Procedure 

 
In this simulation, you will see how to create recurring invoices.   

 
 

Step Action 

1. UVA AP Fellows Stipend Processor >> Recurring Invoices 

 

Click on the Recurring Invoices item. 

 

2. Click in the Supplier: Name field. 

 

3. Enter the Supplier Name.  

 

For this example, enter "FELLOW, AMY" and TAB.  

4. The following information defaults for the Supplier: 

-Supplier Number 

-Supplier Site 

-Accounting Liability Account 

 

Do NOT change the default information. 
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Step Action 

5. Click in the Calendar: Name field. 

 

6. Click on the drop down menu button. 

 

The Calendar Name will default (Fellows Stipend).  

 

7. Click in the Calendar: Number of Periods field. 

 

Note:  A period is a calendar month. 

 

8. Enter the Number of Periods.  

 

For this example, enter "3" and TAB.  

9. Click on the Calendar: First Period button. 

 

10. Click in the Find field. 

11. Enter a "%" in the Find field.  

12. Click on the Find button. 

 

13. Click on and select the Period Name for the first period (month) you want to start 

the payments to the fellow.   

 

14. Click on the OK button. 

 

15. Notice that the Next period and Periods Remaining will default.   

16. Enter information into the Number field.  This is a free form field.   

 

You need to use a prefix that identifies your department or school.  

 

Note:  The invoice number will consist of: the prefix you enter here, the period 

name (Mar) and the calendar year (11).  

17. For this example, enter a "CY".   

 

Note:  "CY" identifies the Chemistry department. 

18. Click in the Description field. 
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Step Action 

19. The Description must always begin with "RIFELLOW".  This helps Accounts 

Payable identify the invoice(s) for those who are considered "Fellows".     

 

Note:  The description must be in CAPITAL letters. 

 

Note:  Enter information about the invoice(s), such as the nature of the payment(s) 

or any other additional information, after the word "RIFELLOW".  

20. For this example, enter "RIFELLOW NIH 2011 GREENHOUSE 

FELLOWSHIP". 

21. Click on the Line Definition tab. 

 

22. Verify that the radio button "Distribution Set" is selected in the Origin area.  

 

Note: Do NOT change it. 

23. Click in the Origin: Name field. 

 

24. Enter the Origin: Name.  

 

For this example, enter "%NIH" and TAB to search for the distribution set you 

created earlier.   

25. Click on the Distribution set you want to use for these recurring invoices. 

 

Note:  The list will contain all distribution sets created at the university.  

 

Ensure that you choose the correct name. 

 

26. Click on the OK button. 

 

27. Click on the Amounts tab. 

 

28. The First Amount field is where you enter the regular monthly amount.   

 

However, you can specify different amounts for two periods.  You will be required 

to specify which period the different amounts will be paid. 

 

Note:  The remaining periods will be paid the amount entered in the First Amount 

field.  

29. Click in the First Amount field. 
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Step Action 

30. Enter the desired information into the First Amount field.  

 

For this example, enter "300.00". 

31. For this example, you will pay the fellow for half of a month because she began in 

the middle of the month. 

 

Click in the Special Invoice Amount1 field. 

 

32. Enter the Special Invoice Amount1.  

 

For this example, enter "150.00". 

33. Click in the Special Invoice Amount1: Period field. 

 

34. Click on the Special Invoice Amount1: Period button. 

 

35. For this example, enter a "%" into the Find field.  

36. Click on the Find button. 

 

37. The Mar-11 item is highlighted. If this is the correct month, then click on 

the OK button. 

 

38. You have the ability to enter another Special Invoice if needed.  

 

Totals: 

-  The Control Total field shows the amount to be paid. 

-  The Released Total will be 0. 

-  The Amount Remaining will be the total amount to be paid. 

 

These amounts will be changed based on the number of recurring invoices you 

create.  

39. Click in the Number of Invoices field. 

 

40. Enter the Number of Invoices you are creating at this time. 

 

For this example, enter "3". 

41. Click on the Create Recurring Invoices... button. 
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Step Action 

42. The Create Invoices page displays the list of invoices you are creating.   

 

This list shows the Invoice Number, GL Date, and the Amount. 

 

If you need to make any changes (such as the number or amount of the invoices), 

click the Cancel button and make changes to the template. 

 

For this example, no changes are needed.  

43. Click on the OK button. 

 

44. The system automatically assigns a voucher number when you click on 

the OK button. 

 

Note:  Annotate the voucher numbers allows you to easily retrieve and approve 

them.  

 

45. Click on the OK button for each payment. 

 

46. Click on the OK button. 

 

47. From the Amounts tab, notice that the Released Total field now shows the amount 

released for the invoices. 

48. Congratulations!  You have successfully learned how to create recurring invoices. 

 

The recurring invoices you created must be approved before they can be paid. See 

"Approving Recurring Invoices". 

End of Procedure. 

Approving Recurring Invoices 

Procedure 

 
The Recurring Invoices you have created must now be "Approved" so they can be paid. 

 

In this simulation you will learn how to find and approve the recurring invoices you created. 
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Step Action 

1. Click on the Payment Voucher link. 
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Step Action 

2. Click on the Find button. 

 

3. Click in the Trading Partner: Name field. 

 

4. Enter into the Trading Partner: Name field the name of the fellow, last name first. 

 

For this example, enter "FELLOW, AMY" and TAB.  

5. Click on the Find button. 

 

6. The search returns a list of all the invoices you created for the fellow.  

7. Notice that the payment vouchers have a status of "Never Validated".   

 

Note:  Each invoice must be in a "Validated" status before it can be paid.   

8. You can approve all the invoices individually one by one or all of them at once, 

using "Shift, Click" and selecting multiple invoices at a time. 

 

Click in the Type field. 

 

9. Press the [Shift] key and click in the Type field. 

 

10. Press the [Shift] key and click in the Type field. 

 

11. Press the [Shift] key and click in the Type field. 

 

Notice that all lines have been selected. 

 

12. Notice that the Actions button has a "3", which indicates there are three invoices 

selected and awaiting approval. 

 

Click on the Actions... 3 button. 

 

13. Click on the All Approvals Have Been Obtained button.   
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Step Action 

14. Click on the OK button. 

 

15. You will receive this note for each of the invoices you are approving. 

 

Therefore, you will click on the OK button three (3) times because you are 

approving three separate invoices at one time. 

 

16. Click on the OK button. 

 

17. Notice the status of the payment vouchers is now "Validated".   

 

This means they are now "Approved".  The payments will be issued approximately 

five (5) days after the invoice date (for this example; Mar 6, April 6, May 6). 

 

The validated invoices will be "Commitment" in grants until the invoice date is 

reached. 

 

After the invoice date is reached, the invoice will become an "Actual". 

18. Use the Scrollbar to move to the right in the Payment Voucher form.   

19. Notice the Payment Voucher numbers automatically populated.    

 

Annotate the Payment Voucher numbers for future reference. 

20. Congratulations!  You have successfully learned how to find and approve the 

recurring invoices you created. 

End of Procedure. 

Running and Printing the Payment Voucher/Invoice Report for UVA 
Fellows 

Procedure 

 
You may need to print the Payment Vouchers you created for the fellow. 

 

In this simulation, you will learn how to run and print the Payment Voucher/Invoice Report. 
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Step Action 

1. Click on the Requests link. 

 

2. The Find Requests page displays.  It automatically defaults to "All My Requests". 

 

Click on the Submit a New Request... button. 

 

3. Click on the OK button. 

 

4. Click on the drop down list of values for the Name field. 

 

The UVA Payment Voucher/Invoice Report name will default. 

 

5. Enter parameters for your request.   

 

If you are printing a single Payment Voucher, enter the Payment Voucher number in 

the "Voucher Number From" and TAB.   

 

If you are running a report for multiple Payment Vouchers, enter a Voucher 

Preparer ID (user ID) AND a range of voucher numbers using the "Voucher 

Number From" and "Voucher Number To" fields. 

6. Click in the Voucher Preparer ID field. 



 

Training Guide 
Training Guide 

 

 Page 125 

Step Action 

7. Enter your user ID into the Voucher Preparer ID field.  

 

For this example, enter "DHW5Y". 

8. Click in the Voucher Number From field. 

 

9. Enter the first Payment Voucher number you created into the Voucher Number 

From field.  

 

For this example, enter "2323206". 

10. Click in the Voucher Number To field. 

 

 

 
 

Step Action 

11. Enter the last Payment Voucher number you created into the Voucher Number To 

field.  

 

For this example, enter "2323208". 
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Step Action 

12. Click on the OK button. 

 

13. Click on the Submit button. 

 

14. Click on the Refresh Data button. 

 

15. There are many phases when submitting a request ID to print. 

 

This request ID is in a "Pending" phase. 

 

As you continue to click on the Refresh Data button, it will move to "Running" 

and finally to "Completed".  

16. Click on the Refresh Data button. 
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Step Action 

17. Notice the phase is now "Completed". 

 

Note: You must have Adobe Reader software that is compatible with your 

Windows version.  Contact your Local Support Partner (LSP) for assistance. 

 

Click on the View Output button. 

 

18. The first page of the report displays.  

 

Page down to view the other Payment Vouchers. 

19. The second page of the report displays information for the second payment voucher 

number. 

 

Page down to view the other Payment Voucher.  

20. The third page of the report displays information for the third payment voucher 

number. 

21. You may print the Payment Voucher/Invoice Report by selecting File>Print. 

 

Another way to print the report would be to click on the printer icon on the browser 

toolbar.   

 

This report should be printed in a landscape orientation. 

22. Congratulations!  You have completed the simulation on how to run and print the 

Payment Voucher/Invoice Report. 

End of Procedure. 

Resolving Problem Invoices 

The AP Invoice Processor is responsible for working with the originator of the purchase order, 
payment voucher, or the PO Buyer, as appropriate, to resolve problems with invoices. 

  

The Invoice Processor is responsible for reviewing invoices on hold, canceling invoices in the AP system and manually 

releaseing holds where authorized. 

Invoices - Running Invoices on Hold Report 

Procedure 

 
In this simulation you will see how to run the Invoices on Hold report. 
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Step Action 

1. To access the report: 

 

UVA AP/PO Viewer >> Other >> Run 

 

Click the Run list item. 

 

2. Click the OK button. 

 

3. Click the Name list of values drop down button. 

 

4. Click the Invoice on Hold Report row. 

5. Click the OK button. 
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Step Action 

6. Enter information as desired on the Parameters page. 

 

No fields are required.   

 

Dates must be entered in the DD-MM-YY format. 

 

Click the OK button. 

 

7. Click the Submit button. 

 

8. The report Phase is Pending. 

Click the Refresh Data button. 

 

9. The report Phase is Running.  

 

Click the Refresh Data button. 

 

10. The phase status is now Completed. 

 

Click the View Output button. 

 

11. Congratulations!  You have completed the simulation to see how to run the Invoices 

on Hold report. 

End of Procedure. 

Invoices - Releasing Invoice Holds 

Procedure 

 
In this simulation you will see how to release an invoice hold so the invoice can be paid. 
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Step Action 

1. To access the required area: 

 

UVA AP/PO Viewer >> Invoices >> Invoices 

  

Click the Invoices button. 

 

2. You may search for the invoice by entering either the Trading Partner name, the 

Invoice Number, or the Voucher Number. 

  

Click the Find button. 

 

3. Review the Holds placed on the invoice. 

 

Click the 3 Holds tab. 

 

4. Choose a Release Name. 

 

Click in the Release Name field. 

 

5. Click the Release Name list of values button. 
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Step Action 

6. Click the NRA Released row. 

 

7. Click the OK button. 

 

8. Click the Actions... 1 button. 

 

9. Click the Invoice Actions Validate  checkbox. 

 

10. Click the OK button. 

 

11. The invoice status is Validated.  The Trading Partner will be paid. 

12. Congratulations!  You have completed the simulation to see how to release an 

invoice hold so the invoice can be paid. 

End of Procedure. 

Invoices - Canceling Invoices 

Procedure 

 
In this simulation you will see how to cancel an invoice. 
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Step Action 

1. To access the required area: 

 

UVA AP/PO Viewer >> Invoices >> Invoices 

 

Click the Invoices button. 

 

2. Click in the Trading Partner: Name field. 

 

3. Enter the desired information into the Trading Partner: Name field.  

 

Enter "Larche". 

4. Press [Tab]. 

5. The Trading Partner's Supplier Number and Taxpayer ID defaults. 

 

Click the Find button. 

 

6. Click the Attachments...(paperclip) icon. 

 

7. Click in the Category field. 

 

8. Enter the desired information into the Category field.  

 

Enter "m". 

9. Press [Tab]. 

10. Miscellaneous is selected. 

 

Click the OK button. 

 

11. The Title field is an optional free-form field.   

 

You may enter either a Title or a Description or both. 

12. For this example, you will enter a Description. 

 

Click in the Description field. 
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Step Action 

13. Enter the desired information into the Description field.  

 

Enter "Canceling Invoice". 

14. Press [Tab]. 

15. Click the Data Type list of values. 

 

16. Click the Short Text row. 

 

17. Click the OK button. 

 

18. Enter the desired information into the Short text Multiline field.  

 

Enter "Enter reason for canceling invoice.". 

19. Click the Save icon. 

 

20. Click the Close icon. 

 

21. You will need to "refresh" your screen in order to see the attachment (yellow paper 

under the paperclip icon).  Following is one method to refresh your screen. 

 

Click in the PO Number field. 

 

22. Click in the PO Number field. 

 

23. Notice the yellow paper is visible under the paperclip icon now. 

 

Click the Actions... 1 button. 

 

24. Click the Cancel Invoices checkbox. 

 

25. Click the OK button. 
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Step Action 

26. Click the OK button. 

 

27. Notice the Note.  This invoice is on Hold.  Before you can cancel it, release the hold. 

 

Click the OK button. 

 

28. Click the 3 Holds tab. 

 

29. Click in the Release Name field. 

 

30. Click the Release Name list of values drop down  menu. 

 

31. Click the NRA Released row. 

 

32. Click the OK button. 

 

33. Click the Actions... 1 button. 

 

34. Click the OK button. 

 

35. Click the 1 General tab. 

 

36. Notice the Status of the Invoice is Cancelled. 

37. Congratulations!  Youhave completed the simulation to see how to cancel an 

invoice. 

End of Procedure. 

 

 


